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Chapter 3:  Using SEER*DMS 
SEER*DMS uses an HTML-based interface displayed via a web browser.  Although the screens are 
displayed in a web browser, the system is not connected to the internet.  Access to the system 
from remote locations is controlled by a firewall that is configured and maintained by registry IT. 

In this chapter, you’ll learn about 

• System Requirements 
• Logging into SEER*DMS 
• Changing Your Password 
• Using the Home Page 
• Account Preferences 
• SEER*DMS Menus 
• SEER*DMS Dos and Don’ts 
• Automatic Logoff Due to Inactivity 
• Using the SEER*DMS Test Server 
• News Items 
• Editing Tips: 

o Viewing More Information on Your Screen  
o Viewing Two Screens at Once  
o Searching for Text 
o Keyboard Shortcuts  

• Recommended Firefox Options 
• Using Filters in SEER*DMS 

o SEER*DMS Manager Pages 
o Filter and Action Toolbar 
o Saved Filters 
o Filters Tab 

• Page and Calendar Tools 

System Requirements 
The following Web browsers are supported:  Mozilla Firefox, Google Chrome, or Apple Safari.  It is 
recommended that you update your browser on a regular basis.  You may not access SEER*DMS 
via Microsoft Internet Explorer at this time. 

Adobe Reader is required to view or print reports (version 9.0 or later is recommended).    

SEER*DMS operates on a server located within the registry and can be accessed by standard 
desktop or laptop computers.  It is recommended that SEER*DMS users, particularly registrars and 
coders, use a computer that has at least one widescreen monitor.  The widescreen monitor should 
have a minimum resolution width of 1680, but an even greater resolution will increase the amount 
of data and text displayed without scrolling.  

• Recommended for registrars and coders:  2 widescreen monitors.  Minimum resolution 
width:  1680, recommended:  1920 or greater. 

• Minimum for registrars and coders:  2 monitors, at least one widescreen.  A second monitor 
is necessary to view coding manuals or to view multiple SEER*DMS pages at the same time. 
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• Minimum to use SEER*DMS (not recommended for registrars and coders): single monitor 
with 1024x768 resolution. 

Logging into SEER*DMS 
To access SEER*DMS, direct your web browser to the address provided by your registry’s IT staff.  
In most cases, a shortcut will be available on your desktop and SEER*DMS will be configured as 
the home page.   A manager or system administrator will create a SEER*DMS account for you and 
provide you with login information.  

 
When you access SEER*DMS, the Login page will be 
displayed as shown here.  Note:  The colors used in 
SEER*DMS are determined by the Color Scheme selected 
in your Account settings. 

Enter your Username and Password.  Click Login.   

 

If a password was sent to you via email, change your password immediately after logging in.  
Please refer to the Changing Your Password section of this chapter. 

 If your login attempt is unsuccessful: 

• User names and passwords are case sensitive.  Make certain Caps Lock is turned off. 
• Contact your supervisor to determine whether your account has been deactivated, or if you 

are subject to a login restriction. 
• If you have forgotten your password, contact a system administrator. 

Login restrictions: 

• If you are unable to log in to SEER*DMS, your account may be subject to a Business 
Hours Restriction.  This restriction blocks access to the system outside of the registry’s 
standard hours of operation.  Your registry’s system administrators have the ability to 
specify the standard business hours in the system configuration settings.  

It is strongly recommended that you log off SEER*DMS when you are not using the system.  If you 
do not log off, confidential data may be displayed on your monitor or be accessible from your 
computer.  Save your current work, if necessary.  To log off, click the Logoff link which appears in 
the top right corner of each page.  Your session will be ended and the Login page will be displayed. 

Changing Your Password 
Registry management can request to have SEER*DMS use the same usernames and passwords as 
the registry’s network (LDAP authentication).  However, most SEER*DMS registries do not use this 
configuration.  Typically, you will have a specific password for SEER*DMS.  SEER*DMS passwords 
have an expiration setting. When a password expires, you will be able to login to the system but 
will be immediately prompted to change your password.  Passwords expire after your first login and 
after logging in with a password assigned by a reset.  In addition, your password will expire 
according to a schedule defined by registry management.   The default setting is 90 days and is set 
in the system configuration (system.password.timeout.days). 
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To change your SEER*DMS password: 

1. You will be prompted to change your password if it has expired.  You may change your 
password at any time by clicking Account in the User Bar.  On the Account page, click the 
Change Password button. This will not be shown if your registry uses LDAP authentication. 

2. Enter your Old Password. 

3. Enter a New Password.  SEER*DMS requires the use of strong passwords to protect 
confidential data.  Your password should not be a common word and should not include your 
name, your child’s name, or your pet’s name.  Your password must: 

a. Be at least 8 characters in length 

b. Include at least 3 of the 4 different types of characters (uppercase, lowercase, digit, 
symbol/punctuation mark). 

c. Not include your username 

d. Not include the same character 3 consecutive times 

e. Not be the same as any of your previous 24 passwords 

f. Differ from your previous password by more than the last character 

4. Re-enter your new password in the Verify Password field and click Save. 

Using the Home Page 
The SEER*DMS Home page is your personalized gateway to the tools and features of the system.   
The home page is displayed each time you login to SEER*DMS.  At any time, you can return to the 
home page by clicking the SEER*DMS logo in the banner or selecting View > Home. 

 
 
Tasks 
The Tasks section on the left side of the home page shows the number of tasks by task type.  You 
can view counts on four tabs:   the tasks assigned to your account are shown on the Mine tab, 
there is a tab for Unassigned tasks, All tasks, and lists of tasks defined by custom filters that are 
Saved.   The task types are links, for example, click Match-Consolidate on the Mine tab to go to 
the worklist.  The worklist filters will be auto-set to show the Match-Consolidate tasks assigned to 
your account.   
 
The Tasks link that appears above the tabs can be used to view all tasks for that tab. For example, 
click Tasks while viewing the Mine tab to view all tasks assigned to your account regardless of task 
type. 

The Tasks section on the right shows the number of tasks by data type.  There are five tabs that 
show data for different years of diagnosis.  The Prior tab shows tasks for years prior to the current 
reporting year.  In the example above, 2009 is the current reporting year.  The Unk tab shows 
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tasks for data with an unknown reporting year (9999).   You would click NAACCR Abstract on the 
2009 tab to work on tasks related to NAACCR Abstracts with a 2009 diagnosis.  

Recently Viewed 
Your most recently viewed records and patient sets are listed on the bottom left of the home page.  
To remove all items from the list, click Clear.  The number of items shown is controlled by a 
setting in your user account.  To change the number of items shown, click Account in the user bar 
and select a value for Number Recently Viewed.  
 
Other features of the SEER*DMS home page: 

• The Latest News section displays News items posted by registry staff. 
• The SEER*DMS Logo, User Bar, and Toolbar appear at the top of every SEER*DMS page.   

o Click SEER*DMS or your registry abbreviation (MDCSS in the screen shot) to return 
to the home page from any page in the system.   

o Click the version (v10.0 in the screen shot) to view the date that the current version 
was released and the date of the initial release of SEER*DMS in your registry. 

 
o The User Bar includes your user name, access to your Account Preferences, and the 

Logoff link.  If you have a system permission to view or edit patient data, it will also 
include the “Lookup” search box (Chapter 20:  Searching for Records and Patients 
has information about the toolbar quick search and other searching techniques.) 

o The name of the current page is displayed on the left side of the Toolbar.  
o The Toolbar also includes menus that provide access to all pages and features in the 

system (see the SEER*DMS Menus section of this chapter). 
o To avoid the loss of effort when using these features, follow the guidelines specified 

in the SEER*DMS Dos and Don’ts section of this chapter. 

Account Preferences 
Your contact information and user preferences are associated with your user account.  To modify 
your account, click Account in the SEER*DMS user bar.   Your user information must include your 
name and a valid email address.  As described below, the User Preferences control various defaults 
throughout the system.  

• AFL Manager Autoload – If set to yes, the default filters will be applied when you first go 
to the AFL Manager. The results table will be populated. If set to no, you must set and apply 
the filters to view results.  

• Audit Log Order - This determines the order that events are listed in Audit Logs (Patient 
Set, Record, Contacts, Facilities, AFL). 

• Date Auto Tab - If set to yes, your cursor will automatically move to the next field when 
you enter a complete value in a date field. 

• Hide Inactive Contacts - This controls the default filter settings when searching for a 
contact. If set to yes, Inactive Contacts will be hidden when you first open the Contact 
Manager and Physician Lookups. 

• Hide Inactive Facilities - This controls the default filter setting when searching for a 
facility. If set to yes, Inactive Facilities will be hidden when you first open the Facility 
Manager and Facility Lookups. 
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• Keyword Match Style - SEER*DMS uses color-coded highlighting to emphasize significant 
words or phrases in text fields. If you select Keyword, the text will be shown in color and 
the background will be the same as other text. If you select Background, a colored box will 
highlight the word. If you select None, the keyword highlighting will be turned off. 

• Number Recently Viewed - This controls the number of records and patient sets listed in 
the Recently Viewed section of the homepage. 

• Patient Lookup Exclusion - Select the value that you use most frequently for the Exclude 
option on the Patient Lookup. This value will be used by default whenever you go to the 
Patient Lookup. 

• System Color Scheme - This determines the palette of colors used in the live or 
production version of SEER*DMS. 

• Test System Color Scheme - This determines the palette of colors used in the SEER*DMS 
test system. You must use a different color scheme when using the test system. 

 

SEER*DMS Menus 
A Toolbar is displayed on every page in SEER*DMS. 

 

The name of the current page is displayed on the left of the toolbar.  On the right, the toolbar 
displays pull-down menus to access various features of the SEER*DMS system.  A full menu or 
menu item will be hidden if you do not have the relevant system permission. 

• View 
o Home 
o Worklist (Chapter 4: Using the Worklist) 
o Patient Lookup (Chapter 20:  Searching for Record and Patient Data) 
o Data Search (Chapter 20:  Searching for Record and Patient Data) 
o Contacts (Chapter 19: Maintaining the Contact List) 
o Facilities (Chapter 18: Maintaining the Facility List) 
o Reports (Chapter 24: Creating Reports and Extracting Data) 

• Manage 
o Abstract Facility Leads (Chapter 21: Managing Abstracting Assignments) 
o Active Follow-up (Chapter 16:  Follow-up) 
o Death Clearance (Chapter 17:  Death Clearance) 
o Follow-back (Chapter 22: Follow-back) 
o Special Studies (Chapter 28: Special Studies) 

• Tools 
o Hematopoietic and Lymphoid Database (Chapter 11: The Patient Set Editor) 
o SEER*Rx (Chapter 11: The Patient Set Editor) 

• System 
o Staff (Chapter 25: Managing User Accounts) 
o Roles (Chapter 26: System Roles) 
o Imports (Chapter 5: Importing Data Files and Chapter 6: Data Entry) 
o Tasks (Chapter 27: System Administration) 
o Edits (Chapter 7: Edit Errors) 
o Keywords (Chapter 9: Screening and Chapter 27:  System Administration) 
o Worklist Flags (Chapter 4:  Using the Worklist) 
o Administration (Chapter 27: System Administration) 
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• Help 
o User Manual 
o Shortcuts 
o Registry-defined configuration settings and algorithms (AFL, Auto-build, etc) 
o Version History 
o Support (Technical Support section of Chapter 27: System Administration) 

SEER*DMS Dos and Don’ts 
You will modify data and access features on system “pages”.  If you are on a page that allows you 
to modify data, you must use the buttons within that page to exit.  These buttons include “Save & 
Exit”, “OK”, “Close”, and “Cancel”.  If you click User Bar links, Toolbar menus, or use keyboard 
shortcuts to leave an editor, changes will not be saved.  Likewise, if you exit an editor by using 
your browser’s navigation controls, unsaved changes will not be saved.   

Do 

• Use the links, buttons, and menus located in the body of the page to complete the current 
task.  If you have made changes that must be saved, do not use the navigation in the 
SEER*DMS logo, User Bar, or Toolbar to exit a page.  

• Click the SEER logo to return to the home page, but only if you saved any changes made on 
the current page or do not wish to save them. 

• Click the links to go the Patient Lookup or your Account; or use the View or Manage menus 
to access system features.  But only use these if you have already saved changes made on 
the current page or do not wish to save them.    

• Use the Tools menu.  The Hematopoietic Database and SEER*Rx tools open in separate 
windows.  You may use these tools while editing data. 

• Use the Help menu to open the SEER*DMS Users Manual.  It also opens in a separate 
window and may be viewed while editing data. 

Don’t 

• Don’t use any browser controls to navigate.  Never use the Back button, Forward button, or 
enter a URL in the address box.  The Browser Navigation Settings section of this chapter 
provides more information about the browser controls to avoid; and methods for hiding 
navigation features that you should not use.   

• Don’t use the backspace key unless you are editing a field.  In a browser application, 
backspace is a shortcut for the browser’s Back button. 

Automatic Logoff Due to Inactivity 
It is strongly recommended that you click Logoff to end your session when not using the system.  
If you do not logoff, SEER*DMS will automatically end your session after a long period of inactivity. 

The system is initially configured to end your session after two hours of inactivity; however, the 
length of time is controlled by a configuration parameter that can be changed per request of 
registry management (system.session.timeout.seconds).   A warning will be displayed two minutes 
before your session will end.  You will have the opportunity to continue the session, if you wish.  
(Note:  the system.session.timeout.warning.seconds configuration parameter actually controls the 
length of time between the warning and the logout.  It is typically set to two minutes.) 

Note: Moving the mouse and entering text do not constitute activity between the browser and the 
SEER*DMS server.  Until you click a button, link, or   lookup to perform an action or access 
another page, your session will be considered inactive. 
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Using the SEER*DMS Test Server 
Two versions of SEER*DMS are available at each registry.  The production or “live” version of 
SEER*DMS accesses the registry’s true database.  A second application and database are available 
for testing and training.  The test server data are reloaded by registry IT staff.    
 
There are visual cues to remind you that you are logged into the test server.  You cannot use the 
same color scheme on the production and test servers; and a green banner is displayed at the top 
of each page on the test server.  Not all users have access to the test server.  Access is controlled 
by a system permission associated with your user account.    
 

 

News Items 
System permissions:  news_add, news_edit, news_delete 

The Latest News list displays messages in the order in which they are added or modified, with the 
most recently modified item appearing at the top of the page.  All SEER*DMS users can view the 
news list, but system permissions are required to add, edit, or delete news. 

To add or edit a News Item: 

1. Click the add item link at the top of the Latest News list; or click the edit link displayed on 
a news item’s title bar. 

2. Enter a Title for your news item.  This field can hold a maximum of 100 characters. 

3. Enter the text of your message in the Body field.  You may enter up to 4000 characters in a 
news item.  You may use the formatting controls to embed links, specify font, font size, 
color, highlighting; created bulleted or numbered lists; and apply other styles to the text. 

4. Click Save.  Your message will appear at the top of the news list. 

To delete a News Item: 

1. Click the Delete link displayed on the news item’s title bar. 

2. SEER*DMS will query you to confirm that you really want to delete the item.  Click OK to 
delete the item or click Cancel to return to the Home page. 
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Viewing More Information on Your Screen 
The data pages in SEER*DMS may contain too many data items to display on your monitor without 
scrolling.  If you would like to view more information on your screen at one time, you may want to 
consider the following: 

• Firefox has a “Full Screen” feature that enables you to hide toolbars and controls that use 
valuable screen real estate.  Press F11 to view SEER*DMS in full screen.  Your Windows 
taskbar and browser menu will be hidden, and a larger number of data fields will be 
displayed.  Press F11 again to restore the Windows taskbar and browser menu.  

• Increasing your monitor resolution will reduce the need to scroll while editing.  Consult your 
registry IT staff for instructions for setting the optimal resolution for your monitor. 

Viewing Two Screens at Once 
SEER*DMS supports the viewing of two or more pages during a single session.  The second page 
will open in either a new Window or Tab, depending on your Firefox settings.  If you are using a 
single monitor, it is recommended that you set Firefox to open new pages in a new tab within a 
single Window (multiple Windows may be hidden on a single monitor).  If you are using dual 
monitors, it is recommended that you set Firefox to open new pages in a new Window and move 
the newly opened Window to the other monitor.   

To open a second SEER*DMS page: 

1. “Middle-click” a link or menu item in SEER*DMS.   To “Middle-click”, you may either click 
your mouse wheel or press CTRL as you click.   The page will open as a new tab or new 
Window depending on the settings in your Firefox options. 

2. Or right-click a menu item or link in SEER*DMS.  A menu will be displayed.  Select Open 
Link in New Window or Open Link in New Tab. 

In the record and patient set editors, the current page will be opened in the new window or tab.  
You can then navigate to the new page. 

Searching for Text 
In Firefox, CTRL-F can be used to search any window.  This is a great tool to use when searching 
for a field in the Patient Set Editor or when searching for text in a popup window.   

1. Press CTRL-F 

2. Enter the search text in the bottom part of the window.  The first occurrence of the text will 
be highlighted. 

3. Click Find Next to go to the next occurrence of the search string or click Highlight All to see 
all matches. 
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Keyboard Shortcuts 

All SEER*DMS Pages 

 

 
SEER*DMS supports keyboard shortcuts for many of the menu 
items and for specific actions.  There is a set of shortcuts that works 
on all pages (shown to the left).  Additional shortcuts are available 
in the Patient Set Editor, Record Editor, and the Pathology 
Screening task (as shown in the diagrams below) 
 
At any time, you may press Ctrl+Alt+H to view the list of keyboard 
shortcuts that are available for the current page.  The shortcuts for 
menu items are listed in the menus.   
 

Patient Set Editor 

 

Record Editor 

 

Pathology Screening 
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Recommended Firefox Options 
As is true of most web browsers, Firefox “remembers” passwords and information entered into a 
form in order to provide suggestions when completing similar forms in the future.  For increased 
security of the confidential patient data in SEER*DMS, you should disable the option to save 
passwords.  To avoid entering one patient’s data into another patient’s form, you should disable 
the browser options to remember information previously saved in forms.  Recommendations for 
options related to new pages were discussed in the Viewing Two Screens at Once section of this 
chapter (the instructions are included here to enable you to set all Firefox options at one time).  

To set the Firefox options as recommended for SEER*DMS: 

1. To give additional space to SEER*DMS, do not show the Firefox Menu bar.  To hide the 
Menu Bar, right-click on an empty section of the Tab Strip and uncheck Menu Bar in the 
pop-up menu. The menu bar will be replaced with a Firefox menu button that will be 
displayed next to the first tab as shown below. 

 

2. From the Firefox menu, select Options. 

 

3. Click the Tabs icon at the top of the Options dialog.  Tabbed browsing allows you to display 
multiple SEER*DMS pages within a single window.  However, a person with a dual monitor 
configuration may prefer to display multiple pages in separate windows.  To open pages in 
separate windows, uncheck Open new windows in a new tab instead.   Check this 
option if you prefer to open pages in tabs within the current window. 

4. Pop-up windows are used to display the print preview for Records and Patient Sets.  To 
ensure that you can print data within SEER*DMS, click the Content icon and set the option 
related to pop-up windows.  You can either: 
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a. Uncheck Block pop-up windows on the Content tab of Firefox options. 

b. Or add the address for SEER*DMS as an exception when you configure Firefox. 

c. Or attempt to print a Record or Patient Set.  Firefox will inform you that pop-ups are 
blocked.  Click Options to add the SEER*DMS address to the list of sites for which pop-
ups will be allowed.   

5. SEER*DMS uses Javascript to display some popup windows.   To ensure that the Text, DX 
Info, and other popups are displayed when open, set these options in the Content section 
of the Firefox options:    

a. Verify that Enable Javascript is checked. 

b. Click the Advanced button for Enable Javascript.  Check the box that says Raise or 
Lower Windows and click OK. 

6. In the Privacy section of Firefox options, change the history setting to Use custom settings 
for History.  Uncheck Remember search and form history. 

7. Click the Security icon and uncheck the Remember passwords for sites box. 

8. Click the Advanced icon and go to the General tab. Uncheck Use hardware acceleration 
when available.  This option may cause SEER*DMS pages to be blurred, therefore, it must 
be turned off.    

9. Click OK to save changes.   

10. Some changes will not take effect unless Firefox is restarted.   To restart Firefox: 

a. At the top of the Firefox window, click on the Firefox button. 

b. Click Exit. 

c. Re-open Firefox. 
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SEER*DMS Manager Pages 
SEER*DMS has several “manager pages”.  These are screens that allow you to view, sort, and 
process lists of items.  For example, the Worklist is a manager for tasks.  Other managers in 
SEER*DMS include the Contact List, Facility List, AFL Manager, Death Clearance Manager, and 
Active Follow-up Manager.   

Each manager has three components:  1) the Filter and Actions Toolbar on the left has a filter 
for each of the key data fields, an Actions menu, and other controls; 2) the Results Tab in the 
body of the page shows the filtered list of data items; and 3) the Filters Tab in the body of the 
page shows the complete list of saved filters in a list that can be sorted and searched.    

 

The data shown on the Results Tab are sorted by the column with a highlighted column header 
(highlighted in green in the example above; other colors are used in different color schemes).   
This example shows the worklist results tab and it is sorted by Task ID.  The up arrow next to 
“Task” indicates that the table is sorted in ascending order.   

You may sort a list by a data item if its column header is underlined.  For example, you cannot sort 
the worklist by ID or Data Type; but you can sort the worklist by Flags, Task, Task Type, User, 
Age, and all other columns.  To sort results by any of the data items, click on the corresponding 
column heading.  To reverse the sort order, click the column header again.  If you create a saved 
filter, the sort order will be stored as an attribute of the filter. 
 
The check boxes in the first column allow you to select individual items in the list.   If items are 
checked, actions are applied to the checked items.  If no items are checked, actions are applied to 
all items in the filtered list.   None of the tasks are checked in the example above.  Therefore, the 
Modify or Export action would be applied to the 5,206 tasks in the filtered list. 
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To hide the toolbar and give more screen real estate to the Results Tab, click the double arrow next 
to the Results Tab.   You can toggle the view when you need to use the toolbar. 

Filter and Actions Toolbar   

 

The worklist toolbar is shown here as an example, but the following 
features are available in the toolbar of all manager pages. 

• Actions – Click the word Actions or the right arrow to open a 
menu. You will use this menu to save filter settings, delete 
saved filters, and export data.  The Actions menu will also 
include options that are specific to each manager page.   

• Drop-down list of saved filter settings – Select a filter from 
the list. The field filters will be automatically set and results 
matching the filters will be loaded. 

• Apply – Refreshes the Results using the current filter settings. 
• Reset – Returns the filter settings to default values.  Defaults 

vary by page and registry.  For example, the default is “User = 
myself” on the worklist; it is typically “Status = Open” on the 
AFL Manager. 

• Save – Stores the current filter settings as a “saved filter”.  The 
value of each individual filter and the current sort order are 
saved.  The filter settings and sort order will be applied each 
time you use the saved filter. 

• Search Box – Enter text into the Search Box to quickly set a 
filter.  SEER*DMS will auto-detect the type of text that you 
have entered, set the appropriate filters, and return results.   

• Filters – Tools that allow you to search for data based on 
individual fields.  Set a filter to limit the results to certain 
values for that field. Instructions for using the different types of 
filters are provided in the Filter Tutorial that is available on the 
SEER*DMS training website:  seer.cancer.gov\seerdms\manual. 

 

Saved Filters 
Once you set the filters, you may save the settings as a Saved Filter.   The value of each filter and 
the sort order will be saved.    

To save your filter settings: 

1. Click Save or select Actions -> Save Filter. 
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2. To create a new saved filter, set Filter to Create New.  If you wish to over-write an 
existing filter, select a saved filter from the drop-down list. 

3. Enter a Name.  If you are modifying a filter and would like to edit the name, click Rename. 

 

4. If you have the permission to manage filters, you will have the option of creating filters that 
are available to other users.    

 

a. To create a filter for yourself or for one other user, select Specific User in the 
Available to drop-down list.  Select yourself or the other person’s user name in the 
User drop-down list. 

b. To create a filter available to all users, select All Users in the Available to list. 

c. To create a filter for a group of users, select Specific Role in the Available to list. 
Select a value in the Role drop-down list. 

5. Enter a Description of the filter.  Any user who has access to the filter will be able to view 
the description on the Filters Tab. 

To use a Saved Filter, select the filter from the drop-down menu in the toolbar on the left side of 
the manager page as shown below; or select the filter from the Filters Tab. 
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Filters Tab 
If you have a large number of Saved Filters, you may find it easier to use the Filters Tab to find 
and apply a filter.  You can use the Firefox Search (CTRL+F) or the search box at the top of the tab 
to find a filter.   The search box returns results based on text in the Name, Description, Created By, 
and Modified By fields.  

 

If you are a filter manager, you will have access to all filters.  Users with the filter_manager system 
permission can access other user’s private filters in order to provide technical support; public 
filters; and their own personal filters. 

 

 

The drop down list on the left has the following choices: 

• My Filters – Use this option to view saved filters that are available for your use.  This 
includes filters available to your user account, filters available to all users, and filters 
available to your system roles.  

• User Filters – saved filters that are available to individual users. 

• Public Filters – saved filters that are displayed for all users. 

• Role Filters – saved filters that are available to specific roles. 

• All Filters – all filters, regardless of their availability. 

Page and Calendar Tools 
Lists shown in SEER*DMS managers, such as the Worklist, often contain too many results to fit on 
the screen all at once.  Therefore, the items will be listed on several pages.  Use the Page Selection 
links displayed at the top or bottom of the list to navigate through the pages. 
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Click Prev or Next to advance one page back or forward.  Click First or Last to move to the 
beginning or end of the entire list.  Click an individual page number to jump to a specific page.  A 
maximum of eight page numbers will be displayed; there may be additional pages that are not 
listed.   

The calendar tool can be used to enter a correctly formatted date in the field adjacent to a calendar 
icon:  

Click on the icon to bring up a calendar of the current month.  The calendar will open with the 
current date highlighted, as shown below. 

 
 
To browse by month, use the < and > buttons at the top of the calendar.  Use the << and >> 
buttons to browse by year.  Use the mouse to click a specific date.  This date will be automatically 
formatted and displayed in the adjacent date field. To close the calendar without selecting a date, 
click the x button in the upper right corner. 

 


